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Abstract: Knowing how to prepare technical reports is vienportant in one’s career.
This report describes a customized style of tectmaper preparation using Microsoft
Word (version XP) for Windows. You are expectedetarn all the details or features of
Word from other manuals. However, this report stidaé a good starting place. This re-
port also describes ways to include tables, figusred graphs; to establish bibliography
databases; and to make a 2-column proceedings tforrhaxpect all my students to use
this unified approach to prepare technical pape@ther than having a unified writing
tool, good writing is even more important as ithe only lasting measure of your learn-
ing and research process. This report also bradhlcribes the typical organization of
research papers. Following these guidelines wikkeraublications easy for all of us.
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1. Introduction

Knowing how to prepare proper technical papersvierg important skill. The purpose of this report
is to show you how to prepare technical papersgusiicrosoft Word (versions 2000 or XP) for Win-
dows, which is probably the most popular word pssagg package in the business world today. As a
professor, | spent a significant amount of time kireg with students on their papers. Unifying thglest
of your papers will make our writing process easiehll my students have to follow the principle pre
sented in this report when preparing technical mspo

You may wonder why | switched from LaTeX to MS Wot@TeX is certainly very nice document
processing software, especially in the handlinggpfations and bibliographical references. If yayport
has heavy equations, you may still use LaTeX. Otiser, MS Word is a better choice for the following
reasons.

« ltis “what you see is what you get” software. Yaan easily modify any portion of the docu-

ment to meet some special constraints, such aslipaitgtions.

« It provides on-the-fly spelling and grammar chesdenething | find very useful.

« It makes paper editing and revision between uslsinigcan use a different color to comment
and annotate on your paper so you know what chdnggge made. To invoke this feature, se-
lect Tools - Track Changes.

¢ It can include all kinds of formats for figures.

« Making tables is extremely easy.

« It has an excellent on-line help and wizards. li get used to it, you don’t need any manuals.

« The paper can be easily converted to HTML formag(click away).

MS Word looks easy to use. Thus, most people cthahthey know Word. In fact, MS Word has so
many features that most people are not aware offun8amental feature is “style”. You should define
different styles for different types of text ingport. If you insert blank lines (a number of “Etitkeeys)
or a number of spaces, you are doing something gurbts Word does have two drawbacks. One is
equation handling. Although it does have an equagiditor, for complicated equatidnslike the intelli-
gence provided by LaTeX. The other is bibliographicandling which is not as powerful as BibTeX.
However, in Section 5, I'll show you a way to getnd this problem.

In the paper, trynot to use absolute indices or numbers for sectioggations, tables, figures, and

even pages. MS Word provides a nice cross refargriechnique for doing it. Udesert > Reference

LMN/HKUST 1



- Cross-Reference to select the right reference. This is a very uisffature that most people do not
use. For example, if you add a new figure in betwedl the following figures will have a new figure
number. Without using the above feature, you haveanually modify each occurrence of those figures.

When preparing a technical paper, the introdugpiart must be clearly written. You have to indicate
the motivation for your work, review others’ woidive a brief description of the problem, and summa-
rize the objectives of the paper. It is importangive credit to other related works. For examijlgou
want to use LaTeX, you may refer to my earlier pdpg

Of course, the most important thing you have torlda how to write a good technical paper, which
includes paper organization, writing styles, etof@sor Don Knuth has an excellent report teacihing
how to write mathematical papers [3]. For exampkesaid, “Don’t start a sentence with an equation o
with a reference.” Thus, the following sentences reot good: X+1 is not always a positive numbBer
and“[2] has done some good workTerminologies must be clearly defined. For #disst time men-
tioned special terms, they must bdtadic form. Check with me to get a copy Mfathematical Writing
by Knuth. For general writing, the bookle Elements of Styl§6]] is a classical and excellent one. The
other two books The Writer's Hotline HandbodK4] and “The Craft of Scientific Writirig[1] are the
ones that | refer to frequently.

The last paragraph in the first section always gjivee organization of the paper. For instance, thi
paper will proceed as follows. In Section 2,?vgart with a description on the global page layout
setup. Section 3 details those customized stylestidh 5 shows how bibliographies are organizeck-Ma
ing figures and tables is not difficult, and isalissed in Section 6. Ways to convert the paperarl-
column proceedings format or HTML format are codene Appendix A. Finally, Appendix B briefly

describes a commercial bibliography managemenivaodt package.

2. Global Setup

Basically, each separate unit in the document, sischaragraphs and section headings, has its own
style. Those styles will be described in the nedtisn. Some definitions, such as page marginsapre

plied to the whole document.

2.1 Page Margins

For the page margins, click ¢ile > Page Setup. Under tatMargins, leave one inch margin for

top, bottom, left, and right. The margin for headed footer is 0.5 inch. Click drormat - Columns

1 | was told that a commercial equation editor Mg is very easy to use. | haven't tried it. Youyrnheck out its web site at
http://www.dessci.com/This package is also useful for generating equatfor web pages.




to define the number of columns on each page.dabhmical reports, use one column. To convert the re
port to conference proceedings, select two equédhangolumns with width 3.1 inches and '0.8pacing

(see Appendix A).

2.2 Footer and Header

Click on File > Page Setup. Under tabLayout, check different footer and header for the first
page. To define a footer and header, click/aaw - Header and Footer. The page number must be
in the center of the footer. Note that you may eanew “section”lfisert > Break -> Section break

types: next page) to begin a new sequence of page numbers and style

2.3  Other Options

Click onTools - Options to define other useful default settings, suchpadliag, grammar, file lo-

cation, etc. You should enable hyphenation by sielg® ools - Language - Hyphenation.

3. Styles

This template document has a number of pre-defitydds. For the main sections, select style “Head-
ing 17. It will automatically assign the next sectinumber starting from 1. Table 1 shows the list o
styles defined for this report. It should be sejplanatory. To apply a style, move the cursor ® $b-
lected unit and then go to the upper left toollbesdlect the desired style.

Table 1. List of styles defined for this report.

Style Font and Size Spacing I ndentation Comments
Fn | Sy| Sz | Sp| Bf | Af FL Lf| Rt | Jf
Abstract | TNR|R |11 | 1.0{12 | 6 none 0,05|B

5
Key- TNR |[R |11 | 1.0|12 | 6 H(0.8) 0.]05]|L
words 5
Notes TNR|R |11 | 1.0{12 | 6 none 0,05]|L
5

Heading | Arial |B |14 | 1.0|18 | 9 H(0.3) of O L Section
I%Ieading Arial [B |12 | 1.0(18 | 9 H(0.3) of O L Sub-Section
ileading Arial [B |11 | 1.0|9 6 none of O L Sub-Sub-Section
I?-,Ie?ding Arial [B |14 | 1.0(18 | 9 none 0| O L Reference
Re

By “we™, | mean myself and the reader.



Style Font and Size Spacing Indentation Comments
Fn | Sy| Sz | Sp | Bf | Af FL Lf| Rt | Jf
Heading | Arial |B |14 | 1.0|0 9 H(1.4) O O L Appendix Heading
Appn
Heading | Arial [B |12 | 1.0|18 | 9 H(0.3) 0| O L Appendix Sub HeadA

Appn 2 ing

Para- TNR [R |11 | 1.5(|0 0 F(0.2) of O B Paragraphs
graph

Indent

ListBul- | TNR |R |11 | 1.5|0 0 H(0.2) .02 |B Bullet Items

0
let 2
ListNbr | TNR |R |11 | 1.5 H(0.25)|0 | O B List ltems
ListNbr | TNR |R |11 | 1.5|0 0 H(0.7) 0| O B Nested List Item
2

o
o

Caption TNR|R |11 | 1.0]|0 0 H(0.3) 0| 0 Reference
Figure TNR|R |11 | 106 0 none 0| O C Figures and tables
Footnote | TNR |R | 9 100 0 none of O B Footnotes

Text
Caption |TNR [R |11 | 1.0(12 | 6 H(0.8) o O C Table Caption
Table
Caption |TNR [R |11 | 1.0|6 12 | H(0.8) of O C Figure Caption
Figure

Table 2. List of abbreviations used in Table 1

Fn Font: TNR (Times New Roman)

Sy | Font Style: B (bold), R (regular), I (italic)

Sz Font Size: points (11 for reports and 10 for prodegs)
Sp | Spacing: 1.0 (single spacing), may use any number
Bf Spacing (points) before the unit

Af Spacing (points) after the unit

FL First line special: none, first line (F), hangird) (

Lf Left indentation

Rt Right indentation

Jf Justification: L (left), R (right), C (center), Bdth sides)

4. Other Issues

There are many other features that may be of ug®uo For example, to generate “Table of Con-
tents”, “List of Figures” or “Indices”, seledhsert > Reference - Index and Tables. The corre-
sponding pop-up window will allow you to define tberresponding style. After the “Table of Contents”
is generated and you have modified some headirmgshgve to move the cursor to the document unit

and right click on the button. From the pop-up mesalecting “Update Field” will update the content.



5. Bibliography

One drawback of MS Word is its rather difficult loling of bibliographies. It does not support Bib-
TeX. You have to define your own bibliography datsd. Described below is the approach | recommend
to use unless you purchase a commercial packagddimdo be described in Appendix B. Note that if
you do not need bibliographies repeatedly for déffee papers, you do not have to build a bibliogyaph

database and may proceed to Section 5.3 directly.

5.1 Database Creation

You may use MS Access for Windows to maintain th#idgraphy database. Please see the sample
file bi bt ex. ndb. Field ID is the unique key to each reference,chwhis same as the key in BibTeX.
Details of each reference are in the “Citationidiel he format of citation follows IEEE Computercso
ety format. The “Complete” box is checked if théerence information in “Citation” is complete, thaf
that all required fields like page number and vatumumber in BibTeX are specified. A nice feature of
this database is the association of each refensitbeup to five keywords. This will make the seafoh
relevant references easier. Since not all refeendébe used in a report, fields “Select 1” tcef8ct 5”
allow you to select a desired subset of refererfeesexample, you may entelPCA3 to the “Select 1”
field of those references you wish to cite in yblRCA3 paper. After all references are selected, you
have to export those selected references to aastegde. Under tab “Report” of MS Access, selesih{
gle click) Citation Select 1. Then click onTools - OfficeLinks = Publish It With MS Word. You
will be queried to enter an appropriate value aflést 1”. In this example, you entdPCA3. All your
selected references will be in a file. Save the ifil MS Word format to be included in your main doc
ment.

Note that with five different select fields, youncaork on five different papers without them intef
ing with each other. Also you may create differbililiography databases for different kinds of refer
ences, such as one for high-speed network andosrempilers. If a document requires referencesifro
multiple databases, you have to extract those erters from each database and save them in different

files to be merged later.

5.2 Reference Style

The extracted references saved in the file,rsgfy. doc, do not follow your expected format style.
You have to edit each reference individually. Fearaple, you have to italicize the name of journals.
Also there are manyab characters generated automatically by the Acogssrr generator. You can

replace all of them by a single space as followgk®n Edit > Replace. Select “Find what:” field.



Then click on “Special” pull down menu to selectAB Character”. In the field “Replace With:”, entar
single space. Then click on button “Replace All”".
If you do not want to create a bibliography databg®u can simply add all references manually in

the Reference section.

53 Reference Section

The last section of your main document is RefereRast, you have to insert your reference files to
this section. Then you have to build cross-refegeabels, one for each reference. At the beginning
the first reference, click omsert - Reference - Caption. There are some predefined labels, such
as Figure, Table, Section, etc. The label | defiferdreferences is “[”. Select label “[". In fieldCap-
tion”, it will automatically assign the next avdila number, starting from 1. You follow it by entey
“1". Repeat this for each of the following referesc To see the list of references under labelclitk
Insert > Reference > Cross-reference. In “Reference Type”, select “[". You will sedl aefer-
ences in the “For which captions” window. Note thatept the assigned number, all other text inferma
tion can be modified in each reference, which bdlautomatically reflected in the “For which captbd
window.

To delete a reference, simply select the wholereefse and delete it. When you try to add a new ref-
erence at the end, it will automatically renumbéreferences in sequence. To insert a new referémc
between two existing references, move the cursdhaadnsertion point and repeat the insertion proce
dure. A correct number will be assigned and allfdtlewing numbers will be automatically incremetite
by one. All the reference numbers in your textutidoe changed automatically (or you may have to
right click on it and select “Update Field”). Wharreference is inserted, by default the styleQap-
tion”, which has been redefined to meet the IEEEramce style. Don't forget to add the TAB characte

after “]".

5.4  Making a Citation

To make a citation in your document, first makeesiire corresponding reference is in the reference
section. When you start to draft a document anchatsure exactly what references need to be iedud
you can add new references to the reference seatiatescribed above. In the “Caption” field, simply
add the reference ID key. After the whole docunmemone, extract the complete reference information
from the database. Then replace the ID key wittctiteesponding reference information.

Now you are ready to move the cursor to the pdiat you want to have a citation. Cligksert >

Reference - Cross-reference. Select the reference in the “For which captiomiidow and select



“Only Label and Number” in the “Insert Reference:"Twindow. Note that the citation number will be

automatically adjusted when the corresponding esfes number is changed.

5.5  Other Approaches

The above method works but is not ideal. For irgagou may need to convert your current BibTeX
database to an MS Access database. My currentagpie to use theci t e{*} command to generate
a . bbl file including all references. Include thdbl file in the Word document and then edit it.
Again a better approach is needed. We may alsotamaiMS Word database files including all refer-

ences and corresponding labels (e.g.&Gtion.doc). Then include the file in your document.

6. Tables and Figures

Figures and tables are frequently used in a documdrhe figures and tables are usually placed right
after the paragraph first referencing it. Each fiigar table should have its caption defined. Thatioa
is usually placed above the table or below therégiihis section describes how to make tablesrdigu

and other related elements, such as theorems.

6.1 Making Tables
Making tables is extremely easy in MS Word. ClickTable - Insert > Table. Select Wizard and

it will guide you to make a table. Once the initiable is made, you can easily change it. You have
know some basic operations. For example, to addvayou have to select a row first. The new row wil
be added above it. You can change the margin oftfude column or just a single cell. To centerlddga
you have to select the whole table first (movedhesor inside the table and then clickTamble > Se-
lect > Table). Then click the right button and sel€all Height and Width. In the pop-up menu, se-
lectcenter.

Table captions must be placed on top of the talide.Insert > Caption to define the table caption
(selecttable within thelabel window). Then you have to apply the st@aption Table to it. When a
table is created, you have the option of decidifgtiver the table can be split into two pages. Ugual
we don't split a table unless the table lengthoiggker than the page length. Unlike LaTeX, you have
move the table up and down to place the tablearright location. This is cumbersome if the papes h

to be edited many times.



6.2 Making Figures

Although MS Word comes with its own drawing todlsisually do not use them. For most of our pa-
pers, MS Visio is an ideal tool. It has many tertggato help you make flowcharts and a variety af di
grams. The best feature of Visio is the abilityledineconnection pointso you can draw a line between
two connection points. To define a connection pangable the connection point toolbar. Then selact
object. To add a connection point, move the cursdhe location, press the Ctrl key and then cthuk
left button. Each connection point is associatetth Wie corresponding object you selected earlidrelv
you move objects, the corresponding connectiontpaiill be moved to keep their relative position to
the object. Visio has many powerful features. Trgut and you will love it. For each figure, makeot
versions: one gray scale for the paper and one tmi@resentation.

When the drawing is done, you can copy and pastdigare to your documehtYou can scale the
figure anyway you want. The figure caption mustpbeced under the figure. Now seldigure instead
of table in the caption window. You have to apply the s$ilgure to the figure itself and the styleap-

tion Figure to the figure caption.

6.3 Making Plots

Plotting curves based on some functions or daés i frequently needed in preparing documents.
The best tool to make plots is MS Excel. Put aift plata and figures in one Excel file, suchT&s96-
06.xls. Within the file, you have many sheets, one sf@eeach figure. Click ofrormat > Sheet >
Rename to give each sheet the corresponding figure ndmenake a figure, you have to copy the data
to the corresponding sheet. Usually each row ofitita, which may have several distinct numberd, wil
be placed in one cell. Click ddata > Text_to_Columns to separate different numbers to different
columns (choose an appropriate delimiter betweesetmumbers, usually “space”). Then select the
region that you want to make a plot. Click on @eart Wizard toolbar to make all kinds of plots. For
most of the plots, choose XY (Scatter) plot. Foilogvthe wizard, you will have a preliminary ploto
can then edit the plot easily. After the plot isdlized, just copy and paste it to your documeset.dB-
fault, it will have a plot boundary box. To remaveselect the figure and click on the right butt@elect
Format Object. Change the Border to None. Once the figure s$guhto the document, it is an object.

You can click orFormat to manipulate the object, such as to center thedias shown in Figure 1. f

% | prefer the “copy and paste” approach. If you timgelnsert> Picture> From File approach, the text of the figure may not
appear correctly when moving to a different machine
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Figure 1. Network latency and throughput relatigpsh
If a plot has many curves, you must be carefupiecefying the curve patterns and colors. Remember

that most publications do not have color. You htavese distinguishable patterns for different carve

6.4  Placement and Other Issues

A major difficulty facing most users is the placerhef figures. When a figure is moved from one
page to another page due to the insertion or deletf texts, the figure may be moved to an incdrrec
position and the corresponding figure caption mayniisplaced. One trick to resolve this problenois t
insert a 2-row 1-colum table. Then put the figuself in the top row and the figure caption in Hwtom
row. You should also change the property of théetathide the table boundaries.

If you do not use MS Visio, you may seldéasert > Picture > New Drawing for other pre-defined
types of pictures. However, it should be noted ihihie inserted figure is in Encapsulated Pospédor-

mat, you won't be able to view it until the wholaper is printed out to a PS printer.

6.5 Making Equations
To make equations, you have to invoke the equatditor by clicking on Insert> Object> MS

Equation 3.0. You have to define the size of supscsuperscript, etc. For example, the followirgms
tence has to invoke the equation editor to makseatsubscripts: “Communication latency contains send

ing latency €seng), receiving latency t..,), and network latencyt{e;), Where the software latency is

defined as (sot =tseng™t rec)- TO €dit an equation, select the equation arak ¢lie right button. Select

Open Equation - Size - Define to define the size of different locations (e.gzesll1 for text, 8 for

subscripts, etc.).



6.6 Theorems and Others

Making theorems, definitions, and lemmas is simitafigures and tables. You have to define these

terms as labels usingsert > Reference - Caption. Then these theorems can be cross-referenced.

7. Paper Organization

A typical technical paper has a number of sectianaddition to the paper title and abstract. Other
than some standard sections, such as introductidrcanclusion, it is up to you to decide the number
and content of the various sections. The bottom ik that you have to organize the paper in athvaty
it is easy for your readers and, more importarthig, reviewers, to follow and to understand yourtgen
butions. Remember that readers, especially revievege busy. They have to decide quickly whether
your paper is worth their time. Keep this in minden writing the paper. The content of some impor-

tant sections are briefly described below.

7.1 Paper Title

Giving a good title is very important as it will lpeattract the interest of intended readers. A titl
should clearly indicate the subject area and thst mistinctive feature. Try to make the title caecil
do not like titles beginning with “On”, such as “®erformance of Parallel Machines”. Just change it

“Performance Evaluation of Parallel Machines”.

7.2 Abstract

If the paper title is attractive, readers will threrad the abstract to decide if they should coetifiine
abstract should cover a general statement of thidgm, the motivation for the paper, some majandss

relating to the problem, the proposed solutiond, @mntributions.

7.3 Introduction

This section tells what the paper is all about. Wesaders probably only read the introduction sec-
tion unless they are really interested in the sttlgesa. This section should begin with a brietcdeson
of the problem. It should include the reasons wtig problem is worth pursuing (i.e., the motivajion
some background information, an overview of thenmasults, and the objective of the paper. A good
introduction should identify the subject precisahd include the assumptions and the importancheof t
problem. A good introduction should give sufficigsdckground material so readers can easily follow

along. It is useful to cite a few relevant surveyctes for interested readers who do not havei@afit
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background and would like to know more on the sttbj€he last paragraph of this section should de-
scribe the organization of the paper. Basicallig #ection gives the roadmap of the paper by summar

ing the content of each section and making an eixpéference to each section number.

7.4 Related Work

This section should review other publications ral@vto your work. It shows your knowledge on the
subject. It is also important to give credits theas. Those authors are likely to be reviewergoofr
paper. For the works that are very relevant tor yeork, you should summarize their approaches, as-
sumptions, contributions, and drawbacks.

In most of the papers, this section is placed rajtdr the introduction section. However, in sorae p
pers, particularly when the contributions are difft to explain at the beginning, this section niey

placed after the main body of the paper. Thus,cauclearly compare your contributions with others.

7.5 Main Body of the Paper

Depending on the nature of the paper, the main lbbdlye paper has a number of sections. Note that
each section should have a precise, concise, aadingdul title. Usually the first section will give de-
tailed and concise description of the problem.hibwdd also include the assumptions or conditions of
your solution techniques. You should include aifigsttion for your work by indicating that your sl
tion was not answered before.

A key section is to describe your “genius” ideastHis section, you should try to follow a sequainti
thinking and solution approach, if possible. Youymaéso divide the method into some units and handle
each unit individually. If your solution is an ahkighm, you should provide a pseudo code to expiaé
algorithm. It will be more readable to use a simgk@ample to illustrate the main concept of the algo
rithm. If the section is too long, try to divideimto some subsections.

In a typical system-related paper, you should feagection on performance evaluation, either analy-
sis or simulation or both. Some plots may be meglito show the characteristics of various key pa-

rameters. You should also compare your results athers if possible.

7.6 Conclusions and Future Work

This is the last section of the paper and shouldnsarize your contributions, discuss the main re-
sults, bring together the loose ends, and makememmdations for future research. | usually read th
introduction and conclusion sections first befoeeiding whether to continue reading or quitting plae

per altogether.
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To most authors, this is probably the last sectiod the most difficult one to write as they havig sa
whatever they have wanted to say already. Mangemsatry to find out new topics from the future

research section. My advice is to not be easilwicaed (or fooled) by the claims in this section.

7.7 References

The list of references contains bibliographicabimfation about each source cited. The style of the
list is different in different publications. | udiyafollow the style defined in IEEE Computer Sdiie
publications. The list of references should beesbdither alphabetically by author last name (prete
approach) or by order of citation in the paper. rllerences listed should be referred to in theepap
When an editor handles the review of your paper dtiitor typically looks at the references to fayt

propriate reviewers.

7.8 Appendices

Some papers have appendices. Usually, you punéhterial that is too nitty-gritty to be included in
the main body of the paper here. This material khba available for readers or reviewers to corwinc

them sufficiently of your arguments, such as lepgtteorem proofs or program listings.

8. Conclusions

| had used r of f since 1978 and had been a strom@f f advocator since then. In the summer of
1989 | started to learn LaTeX and was convincetl thd@eX was a better tool. Since February 1996, |
started to realize the impact of PC and Windowsas forced to learn MS Word due to my job at the
NSF. Having learned all these software packages) tonvinced that MS Word is by far the best and
will dominate the market for a long while. This cepis by no means complete and may not show the
right way to do everything | described as | anl E#rning it myself. There are many features thave
not yet tried. If you find out something useful a@nteresting, let me know so | can include it ie thext
version of this report.

After reading this report, you may ask “It looksogo but how should | get started or what should |
do?” If your report is similar to this report, yaan simply copy this report over and replace al¢hn-
tents. In this way, you can use all the styles ttagfined in this report. You may also create yown
report template. The most critical issue is thathedocument unit should follow a “style”. You shdul
visualize the style of the currently selected takthe time. To enable this feature, selectiogmat >
Styles and Formatting will display a window showing all styles availabMS Word has a large hum-

ber of pre-defined styles. To avoid confusion, aet8how Available stylesat the bottom of that win-

12



dow. Note that you should not create too manyedifiit styles to reduce confusion. You should also
clean up those styles that you do not use. Howgwer must be careful removing a style that may have
been used. To delete a style, first you may hawwdate and modify some styles to suit your ne€ds.
to delete those unused styles as well. For ea@ttsel style in the style window, it will show ai-i
stances of text units that are using the style.t@erosuggestion is to show all control charactengmw

preparing the paper. These control charactersgiitt you hints about the formatting mistakes of the

paper.
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Appendix A. Proceedings Style

Quite often, if your paper is accepted for publmatin a conference, such as ACM or IEEE Com-
puter Society sponsored conferences, you havedpape your paper in the two-column proceedings
format. In the past, you usually had to do cut-padte on big mats provided by the conference. Most
of the conferences now accept camera ready papeasstandard A4 (11 x 8.5 inches) size paper. For
this purpose, you have to change the definitiomlbtyles, mainly the font size. Usually, you hawee

follow the specific requirements provided by thafesence.

A.1  Proceedings Format

Table 3 lists the changes that have to be made wheverting to the proceedings format. All those

changes are in bold face. In order not to exceegb#ige limitation, you may use 0.9 for the spacing.

Table 3. Styles for the 2-column proceedings fdrma

Style Font and Size Spacing Indentation Comments
Fn Sy| Sz | Sp | Bf | Af FL Lf | Rt | Jf
Abstract | TNR| | 10 |1.0]0 6 None [0.0[(0.0|B
Key- TNR |R |10 (10|12 | 6 |H(0.8) [00]|00|L may not need this
words

Notes TNR |R |10 [1.0(|12 |6 |None [0.0|0.0|L removethis
Heading | Arial |B |12 |1.0|12 |6 HO3) |0 | O L Section

1
Heading | Arial | B 11 (10|12 |6 H0.3) |0 | O L Sub-Section
2
Heading | Arial |[B |10 |1.0|6 3 None 0|0 L Sub-Sub-Section
3
Heading | Arial |B |12 |1.0|12 |6 None 0|0 L Reference
Ref
Heading | Arial [B |12 [1.0]12 |6 H(14) [0 | O L Appendix Heading
Appn
Heading | Arial [B |11 (10|12 |6 H(O0.3) |0 | O L Appendix Sub Head-

Appn 2 ing

Para- TNR |R |10 |10 |O 0 FO.2) | 0| O B Paragraphs Indent
graph

Indent

ListBul- [TNR |R |10 [10 |0 0 H(0.2) | 0.200.2|B Bullet Items
let
Caption TNR|R |10 |1.0]0
Caption |TNR |R |10 [1.0] 12
Table
Caption |TNR |R |10 [1.0]|6 12 | HO0.8)| 0 | O C Figure Caption
Figure

o

H(0.3)
H(0.8)

o
o

Reference
Table Caption

o
o
o
@]
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A.2 HTML Format

To convert to HTML format, make sure your MS Womtkage has downloaded the necessary patch

from http://www.microsoft.com/. Then try to saveetfile in HTML format.

A.3 PS Format

To save the file in PS format, you have to prirgt ttocument to a PS printer. In the print menu, you
have to click the option to print to a file. To neagkure it works, you may have to edit the file doform
to the PS format. Use ghostview to preview it firkbwever, don't use the Print command in ghostview
It is extremely slow. If you are sure the PS fdecorrect, open an MSDOS window and execute the com
mand: ‘COPY /B file.ps LPT2:", where LPT2: is the printer port.

Appendix B. EndNote

EndNote is a bibliographic software tool that alkoyou to create, export, import, manage, and store
references into a bibliography library. It has tmajor components: the standalone program to create
and manage your reference library; and the Mictodédrd add-ins (macros) to insert, update, and sort
your references in a Word document. EndNote verSior higher will create a hidden traveling lilyrar
automatically as you cite references in Word. frheeling library which is embedded in the fileddeo
of your Word document, contains complete refereshaa for all of your citations. Therefore, when
sending your Word document to others for editingl aa-formatting, you don’'t need to send an
additional reference library. Complete online doeatation and tips can be found at

http://www.endnote.com/support/.

B.1 Installation and Setup

To install Endnote on Windows systems, simply tum éxecutabl&€N5ul nst . EXE. The Endnote
add-in for Microsoft Word will be automatically ii@dled. For Windows XP, there are some additional
steps that must be taken. In Microsoft Word, cli€kols”, “Templates and Add-ins”, there should be
two EndNote CWYW files listed and they should bbth checked. If you have EndNote 6, then the
files that should be checked are:EN6. CWW dot and EN6. Cww. W | (or
EN6. Qwyw. Wor dXP. wi | if you have Word XP). If you have EndNote 5, thae files that should
be checked areEndNot e5. CWYW dot and EndNot e5. Cww. Wl | . If those files are not there,
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browse to the Endnote installation directory (mosthder Program Files directory) and select them on

by one.

B.2 Building your Endnote Library

The first step in using Endnote is to build yourroveference library (the enl file or the lib file).
You probably have a number of references in moaa thne research area so it will be a good idea to
create one reference library for each. Endnot@atep most well-known reference types such as Con-
ference Proceedings, Journal Articles, Book Secfldmesis, and Report. You can also create custom-
ized reference types. For each reference you tganput, first select the corresponding referetype,
then enter each filed of the reference. For Autirat Editor Names, enter whole names when possible
(they can be abbreviated by Endnote later). Earhenshould be followed by a carriage return when

the reference has co-authors.

B.3 Formatting Output Style

The citation style defines the format of the ciia and references such as reference font stfég; re
ence font size, and what will appear in a citatiofio see a list of predefined output styles, cfieie”
and “Output Style”, then click “Open output stylamager”. The IEEE style is compatible with most
computer science journals and conferences with omhor modifications. Once the output style is

modified, it will be enabled for all the referendsaries.

B.4 Insert Citations into a Word Document

Endnote will create a list of menu items (“Tool$Endnote”) and their toolbars in Microsoft Word.
When you want to insert a citation to a documeaot, ghould first open the Endnote program. This can
be done in two ways: run the standalone Endnotgrano from Windows’ start menu or click the “Go to
Endnote” menu item or toolbar. Either way you vi# switched to Endnote program, where you can
select the reference library. Click the speciéiference, then switch back to Microsoft Word, mthe
cursor to the desired place and click “Insert delécitation(s)” menu item or toolbar. You will lathe
citation created for the reference. To removerdtierence fields in your document for a pure test v

sion, click “Remove filed code(s)”.
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